Design Integration
Using Autodesk Revit® 2011
Architecture, Structure, and MEP

Daniel John Stine CSI, CDT

INSIDE:
MultiMedia DVD
Includes Supplemental Files and Video Instruction

SDC PUBLICATIONS
www.SDCpublications.com
Schroff Development Corporation
Lesson 7
Law Office: ROOF, FLOORS & CEILINGS:

Now that you have the floor plans developed to a point where only minor changes will occur, you can start thinking about the horizontal planes within the building: roofs, floors and ceilings.

In this text you will start with the roof. This is the first element most often modeled of the three elements covered in this chapter. It is first because, with the roof in place, the exterior of the building begins to take its final shape, specifically in 3D and camera views.

Floors and ceilings are then added so the building sections start to take shape. These elements, plus a consultation with the mechanical engineer on the approximate size of the ductwork, will help to determine the distance required between the floors and the roof.

The depth of the structural system is also an important factor when processing the horizontal conditions of your building. This will be covered in the next chapter, but in reality would be considered parallel with the information covered in this chapter via the structural engineer.

Building section showing floors, ceilings and the roof; notice structural and ductwork as well.
Exercise 7-1: Introduction to the Roof Tool

In this lesson you will look at the various ways to use the Roof tool to draw the more common roof forms used in architecture today.

Start a New Revit Project:

You will start a new project for this lesson so you can quickly compare the results of using the Roof tool.

1. Start a new project using the default.rte template.

2. Switch to the North elevation view and rename the level named Level 2 to T.O. Masonry. This will be the reference point for your roof. Click Yes to rename corresponding views automatically.

_TIP:_ Just select the Level datum and click on the level tag’s text to rename.

3. Switch to the Level 1 floor plan view.

Drawing the Buildings:

4. Set the Level 1 Detail Level to Medium, so the material hatching is visible within the walls.

_TIP:_ Use the View Control Bar at the bottom.

5. Using the Wall tool and wall Type set to “Exterior - Brick on Mtl. Stud,” draw a 40’-0” x 20’-0” building (Figure 7-1.1).

_FYI:_ The default Wall height is OK, it should be 20’-0”.
Be sure to draw the building within the elevation tags.

**TIP:** You can draw the building in one step if you use the rectangle option on the Ribbon, while using the Wall tool.

You will copy the building so that you have a total four buildings. You will draw a different type of roof on each one.

6. Drag a window around the walls to select them. Then use the **Array** command to setup four buildings **35'-0" O.C.** (Figure 7-1.2); see the **ARRAY TIP** below.

**TIP:** Zoom in and make sure the brick is on the exterior side of the wall, if not you can select each wall and click its flip icon.

**ARRAY TIP:** Select the first building, select Array, and then, just like the Copy command, define a copy **35'** to the right, and then enter the number of copies.

7. Select all of the buildings and click **Ungroup** from the Ribbon.
Hip Roof:

The various roof forms are largely defined by the “Defines Slope” setting. This is displayed in the Options Bar while the Roof tool is active. When a wall is selected, while the “Defines slope” option is selected, the roof above that portion of wall slopes. You will see this more clearly in the examples below.

8. Switch to the T.O. Masonry Floor Plan view.

9. Select Home → Build → Roof (down-arrow) → Roof by Footprint tool.

10. Set the overhang to 2'-0" and make sure Defines slope is selected (checked) on the Options Bar.

11. Select the four walls of the West building, clicking each wall one at a time.

   TIP: Make sure you select towards the exterior side of the wall; notice the review line before clicking.

12. Click the green check mark, to finish the roof, on the Ribbon.

13. Click Yes to attach the roof to the walls.

14. Switch to the South elevation (Figure 7-1.3).

You will notice that the default wall height is much higher than what we ultimately want. However, when the roof is drawn at the correct elevation and you attach the walls to the roof, the walls automatically adjust to stop under the roof object. Additionally, if the roof is raised or lowered later, the walls will follow; you can try this in the South elevation view by simply using the Move tool. REMEMBER: You can make revisions in any view.
15. Switch to the **3D** view using the icon on the **QAT** (Figure 7-1.4).

**Gable Roof:**

16. Switch back to the **T.O. Masonry** view.

17. Select the **Roof** tool, and then **Roof by Footprint**.

18. Set the overhang to **2'-0"** and make sure **Defines slope** is selected (checked) on the **Options Bar**.

19. Only select the two long (40'-0") walls.

20. **Uncheck** the **Defines slope** option.

21. Select the remaining two walls (Figure 7-1.5).

22. Pick the **green check mark**, to finish the roof, on the **Ribbon**.

23. Select **Yes** to attach the walls to the roof.

24. Switch to the **South** elevation view (Figure 7-1.6).
25. Switch to the 3D view (Figure 7-1.7).

Notice the wall extends up to conform to the underside of the roof on the gable ends.

FYI: You may be wondering why the roofs look odd in the floor plan view. If you remember, each view has its own “cut plane”. The “cut plane” happens to be lower than the highest part of the roof – thus, the roof is shown cut at the “cut plane”. If you go to Properties Palette → View Range and then adjust the “cut plane” to be higher than the highest point of the roof, then you will see the ridge line.
Shed Roof:

26. Switch back to the **T.O. Masonry** view.

27. Select the **Roof** tool, and then **Roof by Footprint**.

28. Check **Defines slope** on the **Options Bar**.

29. Set the overhang to **2'-0"** on the **Options Bar**.

30. Select the East wall (40'-0" wall, right-hand side).

31. **Uncheck Defines slope** in the **Options Bar**.

32. Select the remaining three walls (Figure 7-1.8).
33. Set the **Slope**, or roof pitch, to 3/12 (Figure 7-1.9) on the **Properties Palette**.

34. Click **Apply** on the **Properties Palette**.

35. Pick the **green check mark** on the **Ribbon** to finish the roof.

36. Select **Yes** to attach the walls to the roof.

*FYI:* You can also change the slope of the roof by changing the *Slope Control* text (see Figure 7-1.8); just select the text and type a new number.

*Tip:* You can use the control arrows, while the roof line is still selected, to flip the orientation of the roof overhang if you accidentally selected the wrong side of the wall, and the overhang is on the inside of the building.

37. Switch to the **South** elevation view (Figure 7-1.10).
38. Switch to the **Default 3D View** (Figure 7-1.11).

Once the roof is drawn, you can easily change the roof’s overhang. You will try this on the shed roof. You will also make the roof slope in the opposite direction.

39. In **T.O. Masonry** view, Select **Modify** from the **Ribbon**, and then select the shed roof.

40. Click **Edit Footprint** from the **Ribbon**.

41. Click on the East roof sketch-line to select it.

42. **Uncheck Defines slope** from the **Options Bar**.

43. Now select the West roofline and check “defines slope.”

If you were to select the *green check mark* now, the shed roof would be sloping in the opposite direction. But, before you do that, you will adjust the roof overhang at the high side.

44. Click on the East roofline again, to select it.
45. Change the overhang to $6'-0''$ in the *Options Bar.*

Changing the overhang only affects the selected roofline.

46. Select the **green check mark.**

47. Switch to the South view to see the change (Figure 7-1.12).

That concludes the shed roof example.

**Flat Roof:**

48. Switch back to the **T.O. Masonry** floor plan view.

49. Select the **Roof**(down-arrow) tool and then **Roof by Footprint.**

50. Set the overhang to $2'-0''$ and make sure **Defines slope** is not selected (i.e., unchecked) in the *Options Bar.*

51. Select all four walls.

52. Pick the **green check mark.**

53. Select **Yes** to attach the walls to the roof.

54. Switch to the South elevation view (Figure 7-1.13).
55. Also, take a look the Default 3D View (Figure 7-1.14).

![Figure 7-1.14 Default 3D View – flat roof](image)

56. Save your project as ex7-1.rvt.

**WANT MORE?**

Revit has additional tools and techniques available for creating more complex roof forms. However, that is beyond the scope of this book. If you want to learn more about roofs, or anything else, take a look at one of the following resources:

- Revit Tutorials from the Help pull-down menu
- Revit Web Site (www.autodesk.com)
- Revit Newsgroup (potential answers to specific questions) (www.augi.com; www.revitcity.com; www.autodesk.com)
- Revit Blogs information from individuals (some work for Autodesk and some don’t) www.revitoped.com, insidethefactory.typepad.com
Reference Material: Roof Position Relative to Wall:

The remaining pages in this chapter are for reference only and do not need to be done to your model. You are encouraged to study this information so you become more familiar with how the Roof tool works.

The following examples use a brick and concrete wall example. The image below shows the Structure properties for said wall type. Notice the only item within the “core boundary” section is the Masonry – Concrete Block (i.e., CMU) which is 7⅝” thick (nominally 8”). Keep this in mind as you read through the remaining material.

The following examples will show you how to control the position of the roof system relative to the wall below, both vertically and horizontally. The roof properties that dictate its position basically involve relationships between three things: the Level Datum, the exterior Wall System and the bottom edge of the Roof System. There are several other properties (e.g., pitch, construction, fascia, etc.) related to the roof that will not be mentioned at the moment so the reader may focus on a few basic principles.
The examples on this page show a sloped roof sketched with “Extend into wall (to core)” enabled and the Overhang set to 2’-0”. Because “Extend into wall (to core)” was selected, the bottom edge of the roof is positioned relative to the Core Boundary of the exterior wall rather than the finished face of the wall. See the discussion about the wall’s Core Boundary on the previous page.

Revit Roof Properties under Consideration:

**Extend into Wall:** This option was checked on the Options Bar while sketching the roof.
(To Core)

**Rafter or Truss:** This option is an Instance Parameter of the roof object; the example on the above left, is set to Rafter and the other is set to Truss.

*NOTE:* The “Extend into Wall (to core)” option affects the relative relationship between the wall and the roof, as you will see by comparing this example with the one on the next page.

**Base Level:** Set to Level 2: By associating various objects to a level, it is possible to adjust the floor elevation (i.e. Level Datum) and have doors, windows, floors, furniture, roofs, etc., all move vertically with that level.

**Base Offset:**
**From Level**
Set to 0’-0”: This can be a positive or negative number which will be maintained even if the level moves.
The examples on this page show a sloped roof sketched with “Extend into wall (to core)” NOT enabled and the Overhang set to 2’-0”.
Notice that the roof overhang is derived from the exterior face of the wall (compared to the Core Boundary face on the previous example when “Extend into wall” is enabled).

Revit Roof Properties under Consideration:

**Extend into Wall:** This option was NOT checked on the Options Bar while sketching the roof.

**Rafter or Truss:** This option is an Instant Parameter of the roof object; the example on the above left is set to Rafter and the other is set to Truss. **NOTE:** The “Extend into wall (to core)” option affects the relative relationship between the wall and the roof, as you will see by comparing this example with the one on the previous page.

**Base Level:** Set to Level 2. By associating various objects to a level, it is possible to adjust the floor elevation (i.e. Level Datum) and have doors, windows, floors, furniture, roofs, etc., all move vertically with that level.

**Base Offset From Level** Set to 0’-0”. This can be a positive or negative number which will be maintained even if the level moves.
As you can see from the previous examples, you would most often want to have “Extend to wall (to core)” selected while sketching a roof because it would not typically make sense to position the roof based on the outside face of brick or the inside face of gypsum board, for commercial construction.

Even though you may prefer to have “Extend to wall (to core)” selected, you might like to have a 2'-0" overhang relative to the face of the brick rather than the exterior face of concrete block. This can be accomplished in one of two ways:

(A) You can modify the overhang, while sketching the roof, to include the wall thickness that occurs between the face of wall and face of core: 2'-0" + 9\(\frac{5}{8}\)" = 2'-9\(\frac{5}{8}\)". See the image to the right.

(B) The second option is to manually edit the sketch lines. You can add dimensions while in Sketch mode, select the sketch line to move, and then edit the dimension. The dimension can also be locked to maintain the roof edge position relative to the wall. When you finish the sketch the dimensions are hidden.

**Energy Truss:**

In addition to controlling the roof overhang, you might also want to control the roof properties to accommodate an energy truss, with what is called an energy heal, which allows for more insulation to occur directly above the exterior wall).

To do this you would use the “Extend into wall (to core) + Truss” option described above and then set the Base Offset from Level to 1'-0" (for a 1'-0" energy heal). See the image and the Properties Palette shown on the next page.
Many other properties and techniques exist which one can use to develop the roof for a project. Things like the Rafter Cut / Fascia Depth control the fascia design. Also, you can apply a sweep to a roof edge to add a 1x fascia board around the building. These are intermediate to advanced concepts and will not be covered here.

This concludes the study of the Roof tool!
Exercise 7-2:
Law Office Roof

The template file you started with already has a Roof plan view created. However, you renamed that to Level 2 and then created a new Roof datum and corresponding views. If you recall, the Roof datum is at 26′-8″ (see page 6-34). This Roof plan view creates a working plane for the Roof tool; the thickness of your roof sits on top of the reference plane.

Create a Gable Roof:

1. Open your Law Office BIM file.

2. Switch to the Roof plan view.

Your image should look something like Figure 7-2.1. The exterior walls you can see in the Roof plan view were created in Lesson 6; the specified height extends into the Roof’s View Range. The interior walls and stairs are visible, but are shaded gray (i.e., halftone); this is because of a view setting called Underlay. The Underlay feature is used to visually coordinate items between floors. In the roof plan you might want to know where the wall between the two toilet rooms is to discern where the vent pipe will penetrate the roof.

You will be selecting the exterior walls to define the edge of the roof. Before you can finish a roof sketch, you must have the entire perimeter of the roof drawn with line endpoints connected. Revit allows you to sketch additional lines and use tools like Trim to complete the perimeter of the roof sketch if needed.

3. Select the Roof tool from the Home tab; click the down-arrow.

4. Select Roof by Footprint from the pop-up menu.

5. Make sure Pick Walls is selected Ribbon: Home → Draw (panel).
6. Uncheck **Defines Slope** on the *Options Bar* to make a flat roof.

7. Change the drop-down selector, on the *Properties Palette*, to **New <Sketch>** (Figure 7-2.2).

These are the properties for the sketch lines, not the roof element (compare *Roof Instance Properties*).

8. Notice if this were a sloped roof, you could change the roof pitch here.

9. Change the drop-down back to **Roof** so you can see the roof element properties.

10. Check **Extend to wall core** on the *Options Bar*.

**FIGURE 7-2.1** Roof Plan; initial view

**FIGURE 7-2.2** Roof Properties
We will digress for a moment to explain exactly what “extend to wall core” means. This will help ensure you create the roof correctly. First the properties of the wall will be exposed so you understand what constitutes a wall type core. Next, you will learn how this ties into the Roof tool. If you want to follow along, you can select Cancel Roof on the Ribbon and then repeat the previous steps before moving on to the next numbered steps.

Back on page 6-18 and following you explored the exterior wall style. There it pointed out where to view/edit the “structure” of the wall Layers, via the Edit Assembly dialog. The graphic below shows a variety of wall types with their wall cores highlighted. Within the Edit Assembly dialog, the highlighted Layer(s) fall within the Core Boundary section.

Generally speaking, the Wall Core represents the real-world structural portion of the wall. Walls can be both drawn and dimensioned based on the faces and centerline of the wall core. The Wall Core has a higher precedence when walls intersect. Revit automatically cleans up similar Layers within other wall types. Additionally, in the case of this exercise, the wall core is used in conjunction with creating the roof element. This is also true for floors as well.

Notice a few things about the walls above before moving on. The two walls on the left have the metal stud Layer within the Wall Core, but the masonry cavity wall does not. In the first two, the studs are the structural element holding up the wall, in the latter the CMU holds up the wall and the metal studs are just used to fasten the gypsum board to it. Finally, the fourth wall contains one Layer which is the Wall Core. Every wall must have at least one Layer within the Core Boundary. An example of two Layers within the Core Boundary might be the studs and the sheathing which is used for shear; making both Layers part of the structural makeup of the wall. In this case you would never want any intersecting wall to interrupt the sheathing.

When using the Roof tool, it is possible to have Revit automatically sketch the roof’s edge based on one of the two faces of a Wall Core. Therefore, it is important to select towards the side of the wall relating to the core face you want. The two images below show the two options possible when Extend wall to core is selected within the Roof tool.
Notice in both images above, the gypsum board Layer within the wall type is interrupted by the roof. You will employ the option on the left. However, either option is perfectly valid depending on how the building is intended to be constructed: a separate parapet or balloon framing.

In either case, due to the use of metal studs, the roof deck will be supported by steel beams at the perimeter. The structural system will be added in the next chapter. Revit does not care if a roof or floor is not properly supported, which is not the case with beams, as you will see in the upcoming structural section.

11. Select each of the exterior walls, favoring the exterior side when clicking the wall. Just before clicking, the dashed reference line should be at the exterior face of the wall core per the example shown in Figure 7-2.3.

*Tip:* Use the flip control icon while the line is still selected if your dashed reference line is on the wrong side (i.e., interior).
Note that the exterior walls, just selected, can be selected in any order.

All of the sketch lines should have automatically trimmed at the corners (Figure 7-2.4). If not, you would need to use the Trim tool to close the perimeter of the roof footprint. Many of your 2D drafting skills learned earlier in this book can be applied to this type of Sketch mode.
Take a moment and look at the Properties Palette. As already mentioned, the overall roof thickness sits on top of the Level datum of the view in which it was drawn. Typically, the Roof Level datum relates to the top of the steel beams, thus the roof occurs above that elevation.

Notice the parameter Base Offset From Level. This allows you to enter a distance in which to move the roof up from the Base Level. If you entered 2’-0” and the roof level datum changed, the roof would still be 2’-0” above the repositioned level datum.

Before completing the roof you will learn how to specify the Roof Type. This is similar to walls in that various Layers can be defined within the roof element.

12. Select **Edit Type** button on the Properties Palette.

Notice in Figure 7-2.5 that the **Type** drop-down at the top lists five roof types.

13. Make sure the **Type** is set to **Insulation on Metal Deck – EPDM**.

Now that the roof footprint is complete you can finish the roof.

14. Select **Finish Roof** from the Ribbon.

15. Click **No** to attach walls (Figure 7-2.6).

**FIGURE 7-2.5** Roof type properties; selecting roof type

**FIGURE 7-2.6** Roof Plan; attachment warning
16. Click Yes to join the roof and exterior walls.

Joining the roof and walls via this prompt is what interrupts the stud Layer as shown in the graphic on page 7-20.

FIGURE 7-2.7 Roof Plan; join and cut prompt

17. Switch to your 3D view via the Quick Access Toolbar.

Your project should look like Figure 7-2.8.

FIGURE 7-2.8 3D View; roof added
18. Switch back to your **Roof** floor plan view.

Despite the fact that you just added a roof, which is a solid 3D element, you can still see the second floor walls. When the **Underlay** feature is set, it will show the selected level on top of whatever is visible in the current view. At this point we don’t want to see the **Level 2** walls anymore.

19. Make sure nothing is selected so the **View Properties** are showing in the **Properties Palette**.

20. Set the **Underlay Parameter** to **None** (Figure 7-2.9).

21. Click **Apply** to make the adjustment to the view.

The **Level 2** walls are now removed from the **Roof** plan view.

**FIGURE 7-2.9** Roof plan view; view propertied

At some point in the project you would edit the roof surface to have the required sloped surfaces to shed rain water towards the roof drains. But those types of edits are best saved for later in the design process. If you spent the time to model that information now and then the client decided to make a big change, you would have to redo all that work.

22. **Save** your project.

**TIP:** You have probably figured this out by now: the last view open when you close the project will be the view that is opened the next time the project is opened.
Exercise 7-3:  
Floor Systems

In this exercise you will add the Level 1 and Level 2 floors. The Level 1 floor is a slab-on-grade example, as the building has no basement, and Level 2 is a composite concrete and metal deck floor. Both of these floors are already defined in the project, which stems from the template from which it was started.

Level 1, Slab on Grade:

Sketching floors is a lot like sketching roofs; you can select walls to define the perimeter and draw lines to fill in the blanks and add holes, or cut outs, in the floor object.

1. **Open** your Revit project (Law Office).
2. **Switch to the Level 1 floor plan view if needed.**
3. **Select Home ➔ Build ➔ Floor (down-arrow) ➔ Floor.**

4. Click the **Edit Type** button on the **Properties Palette**.

5. **Set the Type to 4” Concrete Slab** (if not already); see Figure 7-3.1.

6. **Click OK** to accept the change.

Notice, in the **Properties Palette**, the **Height Offset From Level** which allows the slab to be moved up or down relative to the **Level** that hosts the slab.

Also, the **Phase Created** allows you to manage which portion of the building is existing and new. The law office project is all new, so you do not have to worry about any **Phase** settings.
Similar to the *Roof Sketch* mode, you will be drawing the *Boundary Line* for the floor by picking walls. Ultimately your slab will stop at the foundation walls, but they have not been drawn yet so you will draw the slab to the interior face of core. Remember, for the roof you went to the exterior face of core.

7. Make sure the *Ribbon* and *Options Bar* match the settings shown in Figure 7-3.2.
   a. *Boundary Line* selected (*Draw panel*)
   b. *Pick Walls* icon selected (*Draw panel*)
   c. *Extend into wall (to core)* checked (*Options Bar*)

8. Select the interior side of each exterior wall, with the exception of the curtain wall (do not select it yet). See Figure 7-3.3.
You will select the curtain wall in a moment. However, it is a different thickness and does not have a core like the other walls. So, when you pick the wall, the floor boundary sketch line will be centered on the curtain wall. You will have to manually sketch lines and trim them at each end of the curtain wall in order to properly enclose the floor boundary.

9. Select the curtain wall, which in turn adds a curved boundary line.

10. Zoom in to each end of the curtain wall, and select the **Line** icon from the **Draw** panel on the **Create Floor Boundary** tab.

11. Sketch a line, using snaps, from the end of the arc to the adjacent wall sketch line (Figure 7-3.4).

12. Use the **Trim** tool, while still in the **Floor Sketch** mode, to clean up any corners that are not perfect. This is likely only going to be at the transition from the curved wall to the orthogonal walls.

Now that you have the perimeter of the floor defined, you may finish the creation of the floor element.

13. Click the **green check mark** on the **Ribbon** to finish the floor.

**TIP:** If you get any errors, see the next page.
**COMMON ERRORS FINISHING A FLOOR SKETCH:**

If you get an error message when trying to finish a floor sketch, it is probably due to a problem with the sketched perimeter lines. Here are two common problems:

**Perimeter not closed:**
You cannot finish a floor if there is a gap, large or small, in the perimeter sketch. *Fix:* Sketch a line to close the loop.

![Sketch lines – perimeter not closed because line is missing](image)

![Error message after clicking finish sketch](image)

**Perimeter lines intersect:**
You cannot finish a floor if any of the sketch lines intersect. *Fix:* Use Trim to make it so all line endpoints touch.

![Sketch lines – lines extend past each other, not good](image)

![Error message after clicking finish sketch](image)
The floor for Level 1 has now been created. However, because it has no surface pattern assigned to it, you cannot really see it. The only place it is visible is at the two exterior door openings (Figure 7-3.5); this is the best place to select the slab by pressing Tab to get past the door and select the slab.

Often a surface pattern is not assigned to the structural slab. Instead, another floor is added in each room to define floor finishes later during the design process once the plan is fixed. A \( \frac{1}{8}'' \) thick Floor can be created for each floor finish. The \( \frac{1}{8}'' \) Floor is then added to each room, offset \( \frac{1}{8}'' \) from the host level so it is on top of the structural slab. This method allows various surface patterns to be applied. If a surface pattern were added to the structural slab, it would be visible everywhere, such as toilet rooms, the lobby, and the mechanical room. The other benefit is the ability to schedule the floor finishes and get quantities. You can even add formulas to the schedules and get total cost for each flooring type!

**Level 2, Slab on Grade:**

Creating the second and third floors will be a little more involved than the first floor. This is because the upper floors require several openings. For example, you need to define the openings for the stair shaft and the two-story lobby space. However, Revit makes the process very simple.

You will again use a predefined floor type for the Level 2 floor. The floor you will use is 5½” thick: a 1½” metal deck and the remaining is concrete. At this early stage in the project it may be helpful to modify the floor to have a Layer that represents a placeholder for the structural joists that hold up the floor. In section view, this can help better visualize the required space, before the structural engineers add their elements to the BIM.
14. Switch to the **Level 2** floor plan view.

15. Click to start the *Floor* tool on the *Ribbon*.

16. Click **Edit Type** on the *Properties Palette*.

17. Set the *Type* to **LW Concrete on Metal Deck**.

18. Click **Edit**, next to the *Structure* parameter.

You are now in the *Edit Assembly* dialog; here you will temporarily add a *Layer* to serve as a placeholder for the bar joists (Figure 7-3.6). This process is identical for editing Revit walls and roofs!

![Edit Assembly dialog](image)

**Figure 7-3.6** Edit assembly dialog for current floor type.

19. Click the **Insert** button.

The new *Layer* should have been placed below the bottom *Core Boundary* placeholder. This is fine for what we are attempting to do. You will also set the *Function* to “finish” so the walls are not adversely affected by this temporary element in the floor type.
20. Change the new *Layer* as follows (Figure 7-3.7):
   b. *Material:* <By Category>
   c. *Thickness:* 1’-2”

![Figure 7-3.7 Floor properties: layer settings](image)

21. Close the open dialog boxes (i.e., click **OK** two times).

You are now ready to start sketching the boundary of the Level 2 floor.

22. Using the *Pick Wall* icon, select the walls shown in Figure 7-3.8:
   a. Make sure *Extend into wall (to core)* is selected.
   b. Click to the *exterior* side of the exterior walls, opposite to what you did for Level 1.

![Figure 7-3.8 Level 2: Eight floor boundary lines sketched](image)
23. Zoom into the North stair, and make the edits shown in Figure 7-3.9.
   a. Use the **Line** and **Trim** tools from the **Ribbon**. Remember, these are the tools and techniques you mastered in Chapter 5.
   b. The 8'-4” line should align with the top riser, in the North-South direction.

24. While still in **Sketch** mode for the Level 2 floor, pan to the right to show the area in Figure 7-3.10.

You will now define a hole in the floor for ductwork. On a real project, this may be added later in the project once the mechanical engineer gets involved and suggests the size of supply and return air ducts needed. You will add the hole now regardless.

25. Select the **Pick Walls** icon and with **Extend into wall (to core)** checked, select the shaft side of the four walls.
   a. Use the flip-control arrows for each sketch line if needed because the wrong side of the wall may have been selected.
   b. Use **Trim** to clean up the corners.
Whenever a perimeter is drawn within another, it defines a hole.

Next you will define the floor boundary at the two-story lobby, which starts on Level 1.

26. Sketch the floor opening as shown in Figure 7-3.11:
   a. Use the *Split* tool on the sketch line along the exterior wall.
   b. Use the *Line* tool to sketch the floor opening per the dimensions shown.
   c. Use *Trim* as needed to clean up the corners.
   d. You do not have to add the dimensions, but you can if desired. They will be hidden when the floor is finished.

The last area to define is the curved edge at the curtain wall. On Level 1 the floor went under the curtain wall; on Level 2 the floor edge needs to be held back from the curtain wall, allowing room for it to pass by.

27. Using a similar technique as Level 1, sketch the Level 2 floor edge as shown in Figure 7-3.12.
   a. The curved line is 5” in (towards the interior of the building) in relation to the adjacent sketch lines.
**Figure 7-3.11** Level 2 (South-East corner): Floor boundary at lobby

**Figure 7-3.12** Level 2 (South-West corner): Floor boundary at curtain wall
You are now ready to finish the floor sketch and let Revit create the 3D floor object in the BIM.

28. Click on the Ribbon to finish the floor sketch.

29. Click Yes to extending the floor below up to the new floor.

30. Click Yes to join and cut walls.

31. Select the lobby stair and use the Move tool to reposition it as shown in Figure 7-3.13.
Notice, unlike the Level 1 slab, the LW Concrete on Metal Deck has a surface pattern defined, which shows up everywhere. You will leave this for now as it helps to see the extents of the floor in this early design phase of the project.

32. Switch to the **Default 3D View**.

33. Use the **ViewCube** to move around the exterior of your building.

Notice you can see the Level 1 and Level 2 floors through the curtain wall glazing!

![Image](default_3D_view_floors_visible_through_glazing.png)

**FIGURE 7-3.14** default 3D view: floors visible through glazing

The image to the right was generated from the 3D view above. Simply select the floor, click the sunglasses on the *View Control Bar* then select *Isolate Element*.

34. **Save** your project.
Exercise 7-4: Ceiling Systems

This lesson will explore Revit’s tools for modeling ceilings. This will include drawing different types of ceiling systems.

Suspended Acoustical Ceiling Tile System:

1. **Open** your Law Office project.

2. Switch to the **Level 1** ceiling plan view, from the *Project Browser*, ceiling plans are just below the floor plans.

Notice the doors’ and windows’ visibility are automatically turned off in the ceiling plan views (Figure 7-4.2). Actually, the ceiling plan views have a cutting plane similar to floor plans, except they look up rather than down. You can see this setting by right-clicking on a view name in the *Project Browser* and then selecting **View Range** in the *Properties Palette*. The default value is 7’-6”. You might increase this if, for example, you had 10’-0” ceilings and 8’-0” high doors. Otherwise, the doors would show because the 7’-6” cutting plane would be below the door height (Figure 7-4.1).

![FIGURE 7-4.1 Properties: View Range settings](image)

![FIGURE 7-4.2 Level 1 ceiling plan](image)
3. Close the open dialog boxes and then select **Home → Build → Ceiling**.

You have four ceiling types, by default, to select from (Figure 7-4.3).

4. Select **Compound Ceiling: 2'x2' ACT System**.

Next you will change the ceiling height. The default setting is 10’-0” above the current level. You will change the ceiling height to 8’-0”, this will give plenty of space above the ceiling to the bottom of the joists, perhaps for recessed light fixtures and ductwork. This setting can be changed on a room by room basis. Hence, it is an instance parameter.

5. Ensure the **Properties Palette** is visible; type **PP** if not.

6. Set the **Height Offset From Level** setting to **8’-0”** (Figure 7-4.4).

You are now ready to place ceiling grids. This process cannot get much easier, especially compared to other CAD programs.

7. Move your cursor anywhere within the office in the North-West corner of the building. You should see the perimeter of the room highlighted.

8. Pick within that Northwest room; Revit places a grid in the room (Figure 7-4.5).
9. Use the **Ceiling** tool to place 2’x 2’ acoustic ceiling tile (ACT) at 8’-0” above finished floor (AFF) in the rooms shown (Figure 7-4.6).
When you place a ceiling grid, Revit centers the grid in the room. The general rule of thumb is you should try to avoid reducing the tile size by more than half of a tile. You can see in Figure 7-4.6 that the East and West sides are small slivers for the center office on the South exterior wall. You will adjust this next.

10. Select **Modify** from the **Ribbon**.

11. **Select** the ceiling grid identified in Figure 7-4.6. Only one line will be highlighted.

12. Use the **Move** tool to move the grid 12” to the East (Figure 7-4.7).

Moving the grid does not move the ceiling element itself; only its surface pattern.

Next, you will look at drawing gypsum board ceiling systems. The process is identical to placing the grid system.
Gypsum Board Ceiling System:

You will create a new ceiling type for a gypsum board (Gyp. Bd.) ceiling. To better identify the areas that have a Gyp. Bd. ceiling, you will set the ceiling surface to have a stipple pattern. This will provide a nice graphical representation for the Gyp. Bd. ceiling areas. The ceiling you are about to create would lean more towards a commercial application. You will add this ceiling to toilet rooms; as it holds up better in locations with moisture and provides better security. The space above a Gyp. Bd. ceiling is not easily accessible as acoustical ceiling tile (ACT) is, so access panels are often required to access shutoff valves, VAV’s, etc.

The first thing you will do is look at the Revit Materials which are assigned to elements throughout the model. Materials are used to manage the pattern applied to the surface of an element seen in elevation, and the pattern applied when an element is cut in section. Additionally, a color can be selected for Shaded with Edges (Model Graphics Style). Later in the book, you will also learn how a rendering material can be added, which is used when creating a photorealistic rendering.

Several elements can reference the same material. For example, a door, trim, a custom ceiling, furniture, etc., could refer to the same wood material, which could be set to clear maple. If, at any point in the project, the Material for wood is changed to stained oak, all elements which reference it are updated. Thus, if several wood finishes or species are required, you would have to create multiple Materials in Revit.

13. Select Manage  Settings  Materials. This is the list of materials you select from when assigning a material to each layer in a wall system, etc.

14. Select Gypsum Wall Board in the Name list and then click the Duplicate button and enter the name: Gypsum Ceiling Board (see Figure 7-4.8 and image to right).

15. In the Surface Pattern area, pick the button and select Gypsum-Plaster from the list, and then click OK twice (Figure 7-4.8).

The Surface Pattern setting is what will add the stipple pattern to the Gyp. Bd. ceiling areas. With this set to none, the ceiling has no pattern, like the basic ceiling type. Creating a new material allows you to separately control the surface pattern of Gyp. Bd. walls vs. ceilings. Walls do not have a surface pattern typically, whereas ceilings do.

Thus, if you wanted Carpet 1 finish to never have the stipple hatch pattern, you could change the surface pattern to none via the Materials dialog and not have to change each view’s visibility override.
The template you started from does have one Gyp. Bd. Ceiling, but this is meant for a soffit or a small room where the ceiling is not suspended from the structure above; it has 3⅜″ metal studs. You will use this ceiling as a starting point, and create a ceiling with ¾″ metal furring over 1½″ metal studs/channels. All of this is then suspended by wires from the structure above; these wires are not modeled in Revit.

16. From the Home tab on the Ribbon, select Ceiling.

17. Set the Type Selector to 5/8″ GWB on Metal Stud.

FYI: You are selecting this because it is most similar to the ceiling you will be creating.

GWB = Gypsum Wall Board

18. Click the Edit Type button.

19. Click Duplicate and type the name Susp GB on Metal Stud.

At this point you have a new ceiling type available to be placed in the model. However, it is exactly like the one you copied (i.e., ¾″ GWB on Metal Stud). Next, you will modify the composition of your new ceiling type system family.
20. Select **Edit** next to the **Structure** parameter.

21. Create a **Layer** and set the values as follows (Figure 7-4.9):
   
   a. **1½” Mtl. Stud**
   
   b. **¾” Mtl. Stud**
   
   c. **Gypsum Ceiling Board**
      
      *(This is the material you created in Step 13.)*

   **TIP:** Use the Insert button to add a new Layer and then, with the new Layer selected, use the up and down buttons to reposition the Layer within the ceiling system.

22. Click **OK** two times to close the open dialog boxes.

**FYI:** The ceiling assembly you just created represents a typical suspended Gyp. Bd. ceiling system. The Metal Studs are perpendicular to each other and suspended by wires, similar to an ACT system.

You are now ready to draw a gypsum board ceiling.

23. Make sure **Susp GB on Metal Stud** is selected in the **Type Selector** on the **Properties Palette**.

24. Set the ceiling height to **8’-0”**.

25. Pick the two toilet rooms as shown in **Figure 7-4.10**.

**FIGURE 7-4.9** New ceiling – edit assembly
You now have a gypsum board ceiling at 8'-0" above the Level 1 floor slab. Notice the stipple pattern does a good job of highlighting the extents of the Gyp. Bd. Ceiling, as compared to the adjacent mechanical room which will not have a ceiling.

**DESIGN INTEGRATION TIP:** Once the structure and HVAC (i.e., ductwork) have been added, any ceilings will obscure those elements if they are lower in elevation. However, all those elements will show in the mechanical room. Showing the structure and HVAC is great for coordination and helps the contractor understand the project better. For instance, how difficult would it be to paint the Mechanical Room structure and ductwork.

---

**Adding a Bulkhead:**

Next, you will place a ceiling in the hallway. However, you cannot simply pick the room to place the ceiling because Revit would fill in the adjacent lobby and office area. First, you will need to draw bulkheads to close these areas off at the ceiling level. They will not be visible in the floor plan view as they do not pass through its cut plane. A bulkhead is a portion of wall that hangs from the floor or structure above (see image to right) and creates a closed perimeter for a ceiling system to abut into. The bulkhead will create a perimeter that the Ceiling tool will detect for the proper ceiling placement.

26. While still in the **Level 1** ceiling plan view, select the **Wall tool**.
27. In the **Type Selector**, set the wall type to: **Interior – 4 7/8” Partition (1-hr)**

28. In the **Properties Palette**, set and the **Base Offset** to 7'-10". This will put the bottom of the wall to 7'-10" above the current floor level, Level 1 in this case (Figure 7-4.12).

29. Set the **Top Constraint** to: **Up to level: Level 2** (Figure 7-4.11).

   **TIP:** The next time you draw a wall, you will have to change the Base Offset back to 0'-0" or your wall will be 7'-10" off the floor; this is hard to remember!

30. **Draw the bulkhead**; make sure you snap to the adjacent walls (Figure 7-4.12).

---

![Figure 7-4.11 Bulkhead (wall) properties](image1)

![Figure 7-4.12 Bulkhead modeled](image2)
31. Select the *Ceiling* tool and hover your cursor over the hallway.

Notice, in Figure 7-4.13, how the bulkheads create a valid perimeter in the hallway. If the bulkhead bottom was 8'-2" or the ceiling height were 7'-8", Revit would not find this same perimeter. Take a moment and give it a try. Undo any changes before moving on.

![Figure 7-4.13 Ceiling perimeter highlighted](image)

32. With the ceiling height set to 8'-0", click in the hallway to place the 2'x2' ACT System.

33. Reposition the grid as shown in Figure 7-4.14.
   
   a. Sometimes, with odd shaped rooms like this, it can be impossible not to have small slivers of tiles.

![Figure 7-4.14 Hallway ceiling placed](image)

*Design Integration Tip:* In addition to laying out the ceiling tile to minimize sliver tiles, the grid needs to accommodate the lighting design. In the hallway, a full tile is provided down the center with this in mind.
34. Place the remaining bulkheads and 2’x2’ ACT ceilings per the image below; note the ceiling and bulkhead heights vary (Figure 7-4.15).

35. Use the Align tool to make adjacent ceiling grids line up as shown; remember, select the item you do not want to move first.

![Figure 7-4.15 Remaining Level 1 ceilings and bulkheads](image)

You are now ready to move on to the Level 2 reflected ceiling plan. First, you need to create a view in which to work.

36. Select View → Create → Plan Views → Reflected Ceiling Plan.

37. Do the following:
   a. Select Level 2.
   b. Set the scale to 1/4” = 1’-0”

38. Click OK.

You now have a Level 2 ceiling plan view in which to work. It is possible to make multiple plan or ceiling views of the same level (e.g., floor plan, finish plan, code plan, etc.).

Deleting a Ceiling Grid:

When selecting a ceiling grid, Revit only selects one line. This does not allow you to delete the ceiling grid. To delete: hover cursor over a ceiling grid line and press the Tab key until you see the ceiling perimeter highlight, then click the mouse. The entire ceiling will be selected. Press Delete.
39. Using the techniques previously covered, add the Level 2 ceilings per the information provided in Figure 7-4.16.

   a. Rotated ceiling:
      i. Select a grid line.
      ii. Use the **Rotate** tool.
      iii. **Move** the grid as shown.

   b. Bulkhead:
      i. Bottom at **8'-0"**
      ii. Draw with **Arc** tool or **Pick** with offset.
      iii. Show approx. **3'-0"** from exterior wall.

40. **Save** your project.
Self-Exam:
The following questions can be used as a way to check your knowledge of this lesson. The answers can be found at the bottom of the page.

1. You don’t have to click Finish Roof when you are done defining a roof. (T/F)
2. The wall below the roof automatically conforms to the underside of the roof when you join the walls to the roof. (T/F)
3. The roof overhang setting is available from the Options Bar. (T/F)
4. To create a gable roof on a building with 4 walls, two of the walls should not have the __________________ option checked.
5. Is it possible to change the reference point for a temporary dimension that is displayed while an object is selected? (Y/N)

Review Questions:
The following questions may be assigned by your instructor as a way to assess your knowledge of this section. Your instructor has the answers to the review questions.

1. When creating a roof using the “create roof by footprint” option, you need to create a closed perimeter. (T/F)
2. The Defines slope setting can be changed after the roof is “finished.” (T/F)
3. The ceiling grid position cannot be modified. (T/F)
4. To delete a ceiling grid, you must first select the perimeter. (T/F)
5. While using the Roof tool, you can use the ____________ tool from the Ribbon to fill in the missing segments to close the perimeter.
6. You use the ____________ variable to adjust the vertical position of the roof relative to the current working plane (view).
7. While using the Roof tool, you need to select the ____________ tool from the Quick Access Toolbar before you can select a roofline for modification.
8. You need to use the _________ _________ to flip the roofline when you pick the wrong side of the wall and the overhang is shown on the inside.
9. A second, internal, perimeter creates a hole in the floor. (T/F)
10. Changing the name of a level tag (in elevation) causes Revit to rename all the corresponding views (plan, ceiling, etc.) if you answer yes to the prompt. (T/F)

SELF-EXAM ANSWERS:
1 - F; 2 - T; 3 - T; 4 - defines slope; 5 - Y